
The Infozip Interpreter will allow you to run the following games from the
Lost Treasures Of Infocom bumper packs on your 256K Series 3/3a:

Lost Treasures Of Infocom I

ZorkI

Zork II

Zork III

Enchanter

Sorcerer

Spellbreaker

Deadline Moonmist

Witness Planetfall

Suspect Stationfall

Lurking Horror Suspended

Ballyhoo Starcross
Infidel Beyond Zorc (*)

Hitchhiker's Guide To The Galaxy

Lost Treasures Of Infocom II (**)

Cutthroats

Wishbringer
Seastalker

Hollywood Hijinx
Nord and Burt

Plundered Hearts

Border Zone

Sherlock

Trinity (*)

Bureaucracy (*)

A Mind Forever Voyaging (*)

(*) These games which require a full sized screen will only run

successfully on the Series 3a.

(**) To run the larger games (mainly those in Lost Treasures II) use of a
256K SSD is advised.

Both Lost Treasures Of Infocom I and II may be ordered direct from

Interdata Developments.

The Infocom Interpreter

for the Psion Series 3/3a

With

Welcome to Adventure!

✓4 dventttre
The Interactive Original

By Willie Crowther and Don Woods (1977)

AT THE END OF A ROAD

You are standing at the end of a road before a small brick building. Around

you is a forest. A small stream flows out of the building and down a gully.
>

And

0 I4,T&CS

An Interactive Diversion

(By Graham Nelson 1993/4)
ATTIC

The attics, full of low beams and awkward angles, begin here in a relatively

tidy area which extends North, South and East. The wooden floorboards
seem fairly sound, just as well considering how heavy all these tea-chests
are. But the old wiring went years age and there's no electric light.

A hinged trap door in the floor stands open, and light streams in from below
>

An IBM Compatible Computer and Psion 3-Link Serial Cable are required for installation.
As Infocom story files can be quite large use of a flash SSD for the larger games is advised.
This software is not suitable for the 128K Series 3.
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An IBM Compatible Computer and Psion 3-Link Serial Cable are

required for installation NotCS
Published by Lacegem Limited 1994

All rights reserved.

This manual and the programs and data files referred to herein are copyrighted works of
Lacegem Ltd., Activision, Brian Scattergood and Graham Nelson.

LIMITATION OF LIABILITY

In within 12 months of purchase this software can be shown to the reasonable satisfaction

of Lacegem Ltd. to be faulty and not to function substantially in accordance with the user

manual, Lacegem Ltd. will refund the purchase price or refund the product.

Apart from this warranty, Lacegem Ltd. will not in any event be liable for loss, including
consequential loss, caused by any error, defect or failure of the software, or howsoever

arising, including but not limited to loss of use, loss of stored data, loss of profits or loss of
contracts.
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The text on the letter reads

:: and #
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and the stone is inscribed
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The sliding puzzle is best solved using a small font on the 3A, but is
soluble even on the S3.
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Getting Started

Introduction

InfoZip is an application for the Psion series of palmtops (the Series 3,

Series 3a and Acom PocketBook) which allows you to play Infocom

adventure games. Most of the classic Infocom games, as well as games

such as Curses which use the Infocom system, work successfully. The

application is fully integrated, installing into the system screen and using

proportional fonts, pull-down menus and standard file selectors as well as

allowing zooming in the standard manner on the Psion Series 3a.

Throughout the following sections, we will use S3 to indicate the Psion
Series 3 or Acom PocketBook and 3A to indicate the Series 3a.

InfoZip is a version of the shareware application, Infocom, produced

especially for Lacegem Limited as part of their package including Lost

Treasures I. InfoZip is thus commercial and may not be copied, since it

lacks the registration scheme of the shareware version. As a bonus for

Lacegem's customers, a simple but useful cheat application is supplied

which allows you to peer inside the games (see Cheating for details).

Special versions of two games by Graham Nelson are also supplied; these

are documented in the appendix.

Installation

The disk supplied with this manual should contain the applications,
INF0ZIP3.APP and INFOZIP.APR The first of these is a version of

InfoZip for the S3; it will work on the 3A, but only in compatibility mode.
The second is the 3A version, using more memory but adding full support
for the enhanced system. Note that the 3A version will mn on the S3, but

will use significantly more memory with no significant benefits.

As a first step, you need to choose the version of the interpreter appropriate
-3-

Curses

As Curses opens, you're hunting about in the attic of your family home,

looking for a tatty old map of Paris (you're going on holiday tomorrow) and
generally trying to avoid the packing. Aunt Jemima is potting daisies and

sulking; the attics are full of endless distractions and secrets; Greek myths,

horoscopes, sixth-century politics, a less than altogether helpful demon, a

mysterious bomb plot, photography, ritual, poetry and a dream or two all

get in your way; and somehow you keep being reminded of your family
though the ages, and all its Curses ...

... could it be that even you are Cursed?

Curses is a highly original and entertaining game, and has developed

through several releases as Graham added features and puzzles. Each
version has been larger than the preceding one, and for that reason three
versions are supplied Curses 1 is the simplest, being small enough to fit on a

128K SSD. Curses! is the next, being slightly too large to fit on a 128K

SSD, but probably ideal for the internal disk of the 512K 3A. Curses3 is the

most complete, but is 224K in size, so is probably best suited for machines
with external SSDs.

For those who have met Curses before, these versions are derived from

releases 8, 10 and 12 of Curses respectively. The versions become progres

sively more complex, with both extra locations and extra puzzles; both of

these can cause problems if you finish one version and decide to try the
next version along. Extra care needs to be taken since doorways and objects

can appear in 'familiar' locations.

In some places. Curses assumes that the screen has a large number of
colunms, and the display can become messy on the S3 (or the 3A in large

font sizes.) We thus include the following excerpts from the game, for use

when the information is needed to proceed in the game but would be un
readable.

-16-



Bryan Scattergood
Oxford

July 1994

Appendix: More games

Supplied with the Lacegem package, by special arrangement with Graham
Nelson, are versions of two adventures written using Inform, Graham's

compiler for generating Infocom compatible adventure games. The follow
ing introductions to these are adapted from information supplied by
Graham.

Adventure

In the early 1970s, some Massachusetts cavers explored the Mammoth and

Flint Ridge cave system, writing exotic names like Bedquilt, Colossal Cave

and Y2 on their map. One of them, Willie Crowther, programmed a FOR
TRAN simulation that could be "walked" around. Before long, he and a

colleague, Don Woods, filled up the labyrinth with silver bars and pearls, a
rusty iron rod with a star on the end, lantems and keys. The caves came
alive with birds, snakes and bears: Adventure was bom. On mainframes

across the world, it was known as just Advent, because program names

could only be six letters long then.

There have been many, many imitations and cormpt copies. But this is a
faithful version of the 1977 edition, the first Adventure game in the world.

The author first met the game as a version on the RM380Z in the early

1980s, played by up to ten students at a time, fighting to get near the key
board, and has bumped into many version since on many systems. It was

apparently Graham's introduction to adventure games as well, in his case
via an early DEC version. The game has become in every sense a classic,
and Graham's version is as authentic a version as you are likely to ifnd. The

universe of Zork draws heavily on Advent for inspiration.
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for your palmtop and copy it into an \APP\ directory using a Psion serial

link. Details on how to use the link should have been supplied with it; we
describe in detail the procedure for the 3Link cable on the PC. Those using
MacLink, WinLink, PocketFS or Y-modem should consult their documenta

tion as necessary.

If using MCLlnk

Connect the palmtop and the PC using the cable.

Run MCLINK on the PC from a directory containing the application.

Start the Link on the palmtop using Psion-L on the System Screen.

Wait for the "Link Established" message on the PC.

Type COPY INFOZIP.APP REM::M:\APP\ at the MCLINK prompt.

Wait for the transfer to complete.

Shutdown the link using Psion-L again.

Exit MCLINK by pressing return.

Note that if you wish to copy the S3 version or store the application on an

external SSD you should change the application name or the drive letter in
the copy command appropriately.

If using SLINK

If you wish to use SLink in preference to MCLink, perhaps because your
PC is not 100% IBM compatible, then the copying must be driven from the
Psion end of the link as follows

Connect the palmtop and the PC using the cable.

Run SLINK on the PC.

-4-



Connect the palmtop and the PC using the cable.

Run SLINK on the PC.

Start the Link on the palmtop using Psion-L on the System Screen.
Press TAB from the Psion System Screen.

Navigate to the directory on the remote machine containing the application
by using the arrows and Enter and select the application(s) to copy

Press Psion-C (Copy from the File menu).

Enter \APP\ in the "To file: Name" field of the dialogue.

Check the "To file: Disk" field points to the appropriate disk.

Press Enter to start the copy.

Shutdown the link using Psion-L again.

Exit SLINK by pressing Q.

The application can now be installed using Psion-I (Install on the Apps
menu) from the system screen.

You now need to choose a story file to copy to the palmtop. If you have
purchased Lost Treasures of Infocom and have not already installed it on
your PC do so now. You can then select one of the Infocom files, or one of

the files (Curses or Adventure) included on the Infozip disk.

If you are using a 256K machine without any SSD your choice will be
severely limited by the amount of storage remaining. When running, the
application will use around 50K on a S3 and about lOK more than this on a

3A (subsequent games running at the same time will take around 40K

each.) If your machine is particularly full, it may take some reorganisation
to free up sufficient space for the running application and a story file. Zorkl
is recommended as a good starting point, since it is a useful introduction to
the Infocom games and has one of the smallest story files.

-5-

can then print from the word-processor in the usual way.

Acknowledgements

These applications use information on the Infocom game format uncovered
over a period of many years by many other people including Mark Howell,
Graham Nelson and the InfoTaskPorce. The interpreter is derived from the
4.01 release of the InfoTaskForce portable interpreter, although many
sections have been rewritten and additions have been made to support the
Psion environment.
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Cheating

Supplied in the packaging with Lost Treasures lis a manual which contains
the information you need to complete the stories (although it may be well
hidden) as well as a hint booklet, for use only when you are totally stuck.

Using the hint booklet is seductive and can totally ruin your enjoyment of
the story; I keep the manual at home and the hint book hidden in a
cupboard in the office.

In the same way, you need an interpreter like InfoZip to play the stories,

while InfoStat is an application to tell you more than you want to know
about them. Using it on a story which you have not ifnished may reveal far
too much, but it is included since it can also reveal interesting comers of

those which you have ifnished.

When installed, it presents a list of stories in the same way as InfoZip, but
when selected it displays information about the ifle. There are three
screens, accessible from the View menu:

STATS: lists simple statistics about the ifle, and is displayed initially.

WORDS: lists all the words understood by the story, trimmed to 6 or 9

characters and broken down into paragraphs according to initial letter.

ITEMS: lists all the locations and objects in the story, along with their
initial location (if any.)

Note that the list of items may contain some objects with bizarre names or

initial locations; these are present purely for purposes internal to the game.

For example, Graham Nelson's games all contain an object called "com
pass" which is where all the walls are stored.

The views are all read-only, but their contents may be copied into other

applications using Psion's 'Bring' functionality; for example if you want to
print a list of all the words understood by the game, then select the text in
the Words view, switch to an empty Word document and type Psion-B. You

-13-

The story should be copied using the link software, as outlined above, with
the story being placed in an \IDF\ directory with an IDF extension. Thus, if
you are copying Zorkl as suggested, the command to use with MCLINK is

COPY Z0RK1.DAT REM::M:\IDF\Z0RK1.IDF

again changing the drive letter as appropriate. This should result in the
name of the story ifle appearing in the list below the application icon (you

may need to press the System button if you have automatic update disa
bled.) You should then be able to start the story by pressing Enter over the

name of the ifle in the usual way.

You should also ifnd on the enclosed disk the following ifles:

INFOSTAT.APP The cheat application

ADVENT.IDF Data ifle for Adventure

CURSES 1.IDF

CURSES2.IDF

CURSES3.IDF

README.TXT

LTI. EXE

Data ifle for Curses 1

Data ifle for Curses 2

Data ifle for Curses 3

A readme ifle containing late breaking information

A self extracting ifle of useful information relating
to various Infocom adventure games

The cheat application should be installed in the same way as InfoZip. For

more information on Adventure and Curses see the Appendix. Adventure
and Curses 1 also make good choices for your ifrst story ifle especially

Curses 1 which is completely self contained including all information (and
hints) required to complete the game.

-6-



Using InfoZip

Features

The application follows all the usued conventions of the S3 and 3A, so most
commands are available from the pull-down menus activated by the Menu

key. Nevertheless, some features are not apparent at first glance, and these
are detailed below.

Editing

When entering commands, full command line editing is available using
emacs or Psion style keystrokes. The full set of commands is

Psion Emacs Action

Left Control-B Move back one character

Right Control-F Move forward one character

Psion-Left Control-A Move to start of line

Psion-Right Control-E Move to end of line

Delete Control-H Delete character left

Shift-Delete Control-D Delete character right
Control-U Delete entire line

Control-K Delete to end of line

Also, a history of recent commands is maintained eind can be stepped

through using the up and down arrow keys (or Control-? and Control-N if
preferred). This is useful for retrieving the previous command to correct a
typing error, for example.

When output is paged (when More is displayed) hitting space or enter will
scroll by one screen. If however any non-control key is pressed, then the
display will scroll immediately and the key will not be discarded; this is to
prevent the pages interfering with type-ahead for those who are familiar
with the story and wish to rush through some areas.

-7-

Series 3a only: A Mind Forever Voyaging, Beyond Zork, Trinity and

Bureaucracy.

Series 3 and Series 3a; Ballyhoo, Border Zone, Cutthroats, Deadline,

Enchanter, The Hitchhiker's Guide to the Galaxy, Hollywood Hijinx,

Infidel, Leather Goddesses of Phobos, The Lurking Horror, Moonmist,
Nord and Bert, Planetfall, Plundered Hearts, Seastalker, Sherlock, Sorcerer,

Spellbreaker, Starcross, Stationfall, Suspect, Suspended, Wishbringer,
Witness, Zorkl, Zork2 and Zork3.

Problems

InfoZip and its shareware relative have been in use and almost continuous

development for over fifteen months, during which time many bugs have

been eradicated and, alas, some replacements have almost certainly been

introduced. If you have a problem with the interpreter which is not men
tioned below, then please write to me care of Lacegem, and Til do my best

to fix it. If you are stuck with a particular game, then see the next section.
There are however a few known problems

1. The status bar is the wrong size after zooming. On later games, the status

bar is drawn by the game itself, rather than by the interpreter. Since the

games do not expect the number of columns to change while the game is

running, some of them draw a line of the wrong size after zooming. This is

unavoidable; very few other interpreters allow resizing in this way at all.

2. Zooming doesn't work. Zooming is disabled (for horrible technical
reasons) when the game is paused for More. Also, the Series 3 font is

available in only one size, so zooming has no effect when it is in use.

3. The game freezes. The More prompt is displayed at the top-right for two
seconds, after which it is removed; often all that is need to un-freeze the

game is to press a key.
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Things You Should Know

Compatibility

The application has been tested with a wide variety of stories, including the
complete contents of both Lost Treasures I and n. The results of these tests
are given below, but first we discuss some background issues which should
allow you to predict whether another story is likely to work successfully.

Infocom games can be divided into 6 generations, three of which are sup
ported by the current version of InfoZip. Generations 1 and 2 cover games
produced for the Apple n and TRS-80 in the period up to 1982. Generation
3 covers the majority of games produced from 1982 onwards, being slowly
phased out after generation 4 was introduced with A Mind Forever Voyag
ing in late 1985. Generation 5 was introduced for Beyond Zork and Border
Zone in 1987, with some earlier games being re-released to make use of the
new format with on-line hints being incorporated. The final generation

appeared in 1989, with Zork Zero, Shogun, Arthur and Joumey.

Generation 1 and 2 games are no longer available, and generation 6 games
are large and are still not fully understood, so InfoZip currently supports
generations 3,4 and 5. In general, this means that most games which are
obtainable and can reasonably be held on a Psion can be run.

Screen limitations on the S3 mean that Bureaucracy (which needs more

rows and columns than the display can accommodate for its "registration
form") will refuse to run, and similarly the on-line help system present in
some of the later games is unusable on the S3 or when using a large font on
the 3A. There are similar problems with A Mind Forever Voyaging, Beyond
Zork and Trinity.

In summary, the Infocom games break down into three groups

Unusable; Zork Zero, Shogun, Arthur and Joumey.

-11 -

Saving and restoring

The standard way of saving positions from Infocom games has been to
prompt the user for a file name after the command "save" has been given to
the system. InfoZip is no exception, and typing save will indeed produce a
simple prompt for a file name. However, it also allows ifle names to be
entered using the standard Psion ifle selector as shown below

Jopyright tcj l yy574 bg Graham Nelson. New players should type'
Release 10/ Serial number 940120 (Compiled by Inform u1171)

NarneHSauegame.sau
Internal

re in a relatively tidy
orboards seem fairly
ests are. But the old

nttic

The attics, full of lowl
area which extends m

sound, just as well cc
wiring went years ago,|

n hinged trapdoor in the floor stands open, and light streams in from below.

>

The selector can be reached using the Save option on the File menu. If the
save command has not already been typed into the game, then it will be
entered automatically, allowing the selector to be used after typing save if
desired.

The restore command works in the same way, offering the choice between

operating fully from the menu, using a ifle selector after typing the com
mand or typing the ifle name in full without making use of the Psion ifle
selector at all.

Saved positions are, by default, kept in the \SAV\ directory of the default
disk with a SAV extension. File names which are entered manually will

have both this directory and extension supplied if none was given.

Note that InfoZip generates compressed save positions which are typically
less than 10% of the size of the positions generated by other interpreters. In
general, even if the compression was not present, saved positions are not
portable between interpreters, so you cannot save a position on one
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interpreter and restore it under any other interpreter on any other platform.
However, derivatives of InfoZip are available for the Acorn Archimedes and
XI1 under UNIX and InfoZip can exchange saved positions with these

interpreters.

Display setup

In the usual manner, Control-Menu enables the status window as shown

below. This option is supported only in the 3A version, since it requires the
reformatting code to be present

core :

lere In a relatively tidy area which extends nor
south and east. The wooden floorboards seem fairly
sound, just as well considering how heavy all these
teachests are. But the old wiring went years ago, and
there's no electric light.

A hinged trapdoor in the floor stands open, and light
streams in from below.

Ued 8>■

On the S3, the only display option is Justify on the Special menu, which
controls whether additional spacing is inserted into lines to produce an even

right-hand margin

On the 3A, many more options are available and these are controlled using

the Preferences option on the Special menu. Justification can be controlled
from here, as can the choice between font families as shown

Copyright (c) 19S3/'4 by Grdham Nelson. New players should type
Release 10 / Serial nuinber^940120 (Compiled by Inform u1171)

Attic

The attics, full of lou beams
area which extends north, s
sound, just as well consider
wiring went years ago, and t

= vfl

Preferences

•Justify

■Size

Roman

Swiss

A hinged trapdoor in the floor stands opt

Mono

SeriesS

11 here in a relatively tidy1 floorboards seem fairly
ichests are. But the old

it streams in from below.

The fonts are also available in a variety of sizes which can be selected from

the final item in the dialogue. In addition, the Special menu contains the

standard 3A options of Zoom in and Zoom out which cycle through the
available sizes in the current font family.

Since so. many choices are available when configuring the display settings
on the 3A, the most recently selected settings are retained and will be used
the next time the application is run.

f Info File
consi 1-.

are. But the old wiring wi
there's no electric light.

fl hinged trapdoor in the floor stands open?
and light streams in from below.

>
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